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ABSTRACT 

Spike protein is present on the exterior of SARS-CoV-2 that mediates the binding of 

virus with human ACE2 receptor. S-protein has the ability to mutate in a short span of time. 

Using S-protein as a therapeutic target, Covid-19 infection can be prevented. Many plant-

derived phytochemicals are found effective to treat viral infections. In this study, we selected 

top 10 phytochemicals following the Lipinski’s rule of five from total 82 candidate 

phytochemicals. The binding energies were determined through molecular docking of the 

phytochemical ligands. Top three compounds having maximal interactions and lowest 

binding energies were visualized.  We suggested Dictamnine, Deoxypodophyllotoxin and 

Deoxyartemisinin as therapeutic agents for Covid-19. The lowest binding energy was 

observed for Dictamnine (-20.4) followed by Deoxypodophyllotoxin (-20.1) and 

Deoxyartemisinin (-15.6). This study suggested the binding energies with the highest 

negative value are more effective to treat viral infection caused by SARS-CoV-2. Further 

studies on mechanism of actions, bioavailability and clinical trials can provide a clear way for 

the development of effective compounds that can pave the way for the discovery of the 

effective drug Covid-19 infection. 

Key Words: Covid-19, drug designing, molecular docking, phytochemicals, spike proteins. 

Abbreviations: ACE: Angiotensin Converting Enzyme, ADME: Absorption, Distribution, 

Metabolism and Excretion, WHO: World Health Organization, 3D: 3-Dimesional. 

INTRODUCTION 

SARS-CoV-2, the agent 

responsible for coronavirus infection was 

declared the global pandemic by WHO 

(He et al., 2020; Kannan et al., 2020; Lu et 

al., 2020; Park et al., 2020). It affects the 

respiratory epithelial lining of humans 

(Azkur et al., 2020; Guan et al., 2020). 

Club-shaped, type I glycoprotein spikes 

are present on the virus. Infection occurs 

due to the coupling of S-protein with the 

human Angiotensin converting enzyme 2 

(ACE2) receptor (Cui and Shi, 2019; 

Wang et al., 2020). 

 

 

Spike protein (S-protein) has two domains, 

one helps in recognizing and binding with 

host cell while other mediate the access in 

the host cell membrane by penetrating it 

(Li, 2016; Kakodkar et al., 2020; 

Mohamadian et al., 2021). Therapeutic 

targets help to prevent infections as it 

block the interaction between host 

receptors and infectious agents. Known 

therapeutic targets for combating this virus 

are S-protein and ACE2 receptors. Thus, 

manipulation of S-protein and ACE2 

receptors can obstruct the binding, and as a 

consequence prevent viral entry into the 

host cell.  
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Phytochemicals are non-nutritive 

chemicals derived from plants e.g. 

alkaloids (block the active site of virus and 

results in reduced viral titers) and 

flavonoids (inhibits the reverse 

transcriptase and replication) (Edoga et al., 

2005; Yadav and Agarwala, 2011). 

Phytochemicals have anti-inflammatory, 

anti-oxidant and anticancer properties 

(Han et al., 2007; Ali et al., 2008; Yadav 

and Agarwala, 2011). These are important 

component of ethnomedicines and 

ethnopharmacology (Govindappa et al., 

2011) and play key role for development 

of many drugs. Phytochemicals do not 

harm the humans and help in regulating 

certain cellular pathways. 

The need for the development of an 

effective drug to treat viral infections has 

always been a challenge for humans. 

Scientists are trying their best to find a 

cure for this viral infection and have found 

that some phytochemicals effective against 

viral infections including Covid-19 

(Catanzaro et al., 2020). The use of 

pharmacological plants has a usual 

inclination for treatment purposes. Plants 

based medicines along with computational 

drug designing are considered an effective 

approach for development in drug 

discovery (Black, 1996; Sliwoski, et al., 

2014; Dali et al., 2019).  

There is no evidence for the 

availability of 100 % effective drugs 

treating this infection. The in-silico 

method of drug designing has gained 

significant importance as it provides an 

estimate of the effectiveness of the drug 

and is cost-effective. Contextually, in-

silico determination of better drugs can be 

best method over laboratory procedures. 

We aimed for the use of in-silico method 

to design a cheap and serviceable drug for 

the treatment of Covid-19. For this 

purpose, plant derived phytochemicals and 

their effect on inhibiting the entry of virus 

were studied. Many phytochemicals were 

selected and their effect for inducing a 

conformational change and inhibition of 

spike protein and ACE2 complex was 

studied through molecular docking 

analysis. Present research can deduce huge 

pile of biomedical information for in-silico 

drug designing. Additional works to 

expound the possible mechanisms of 

phytochemicals against Covid-19 and 

bioavailability of these alkaloids are 

recommended.  

MATERIALS AND METHODS 

Data Retrieval and Visualization 

The step-wise process that leads to 

the drug designing involves the 

identification of the target protein, 

comparative modeling, screening, 

molecular docking, and then the drug is 

subjected to clinical trials (Ou-Yang et al., 

2012). All the data were retrieved by 

aforementioned steps. Phyre2 is an online 

tool based on the principles of homology 

modeling. It was used for the retrieval of 

3D structures of proteins.  Spike protein 

structure was downloaded from phyre2. 

PyMol was utilized for visualization of 3D 

structure of S-protein. It was also used to 

notice the interactions between protein and 

ligand. 

The three-dimensional structure of 

ligands was retrieved from the online 

chemical database PubChem. The ligands 

were saved in SDF format along with the 

molecular structure and canonical smiles. 

PDB format of ligands is required because 

our software supports only PDB format. 

The conversion of SDF format into PDB 

format was done by online SDF to PDB 

convertor in the following order; 

Open online SDF to PDB convertor > 

select PDB and 3D > Browse > select 

SDF file > open >Translate > Save 

We installed the MGL tools and 

AutoDock Vina software for conversion of 

S-protein into PDBQT format for 

molecular docking (Linota et al., 2014; 

Joseph et al., 2017). In the AutoDock tools 

the PDB file of the S-protein was opened 
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through (File ˃ read molecule 

˃destination ˃file name ˃open). 

After opening PDB file, water 

molecules were removed by Edit ˃delete 

water order and H atoms were 

supplemented via (Edit ˃ hydrogens ˃ 

Add ˃ polar only ˃ ok). Subsequently, 

protein structure (in PDBQT format) was 

saved. During target residue selection, 

PDBQT format of S-protein was opened 

into Auto Dock by executing (File > Read 

Molecule > select file > open) steps. Then 

the target amino acid residue was selected 

by (Select > Select from string > Residue 

> Add > Dismiss). 

After residue selection, the grid 

box was generated by setting in (Grid > 

Grid Box). Then values for x, y, z 

dimensions were set by keeping spacing at 

1.000 angstroms. The values for x, y, z 

dimensions were set in such a way that the 

target residues PRO330, CYS336, 

GLU340, ALA372, and CYS379 should 

have in the center of the grid box from all 

the sides. The aforementioned residues are 

active sites for the ligand to bind with. 

Auto Dock tools were also used for the 

format conversion of PDB files of ligands 

into PDBQT. (Ligand ˃ input˃ open˃ 

destination˃ file name (type PDB files) 

˃open). In the final step, Molecular 

docking was performed using Auto-dock 

vina. 

The ligands that followed 

Lipinski’s Rule of Five and showing a 

negative sign for binding energy with high 

value were selected for Molecular docking 

(Linota et al., 2014; Joseph et al., 2017). 

Docking outcomes were observed by 

PyMol. Separate window was used to 

evaluate the protein-ligand interfaces and 

connected sites. Polar contact, angel, and 

dash view were set to observe the 

interaction between ligand-protein at the 

right place. All possible results obtained 

after docking was visualized in this way. 

 

 

RESULTS  

Present work includes the designing 

of an effective drug to treat covid-19. For 

selecting some candidate phytochemicals, 

82 phytochemicals were studied on the 

basis of binding energies and interactions 

to the target proteins (Table S1 in 

Supplementary Material). Further, 

Lipinski’s rule of five assisted in screening 

out 40 phytochemicals. The alkaloids were 

selected for their drug like properties, 

affinity with S-protein and number of 

binding residues (Table S2 in 

Supplementary Material). To avoid any 

failure in most probable drug selection; 

absorption, distribution, metabolism and 

excretion properties (ADME) were applied 

on 40 phytochemicals. We are suggesting 

following three lead compounds to be 

highly effective against Covid-19 (Table 

S3 in Supplementary Material). 

i.  Dictamnine 

The highest negative binding energy 

was observed by Dictamnine (-20.4). It 

interacted at THR 430 (CO-OC, 3.1), PHE 

515 (CO-OH, 3.0), LEU 517 (CN-OC, 

2.9), HIS 519 (CN-OC, 3.3), and HIS 

519(CN-OC, 3.2) residues as shown in Fig 

1 (b). Higher the negative binding energy 

of the ligand, the higher will be the 

suitability to interact with the target 

protein. The ADME properties of this 

alkaloid show that it can be used as a 

dominant therapeutic agent. This 

phytochemical interacted with five various 

residues and can be used effectually to 

block the activity of the target protein. The 

binding affinity and the interactions of 

other phytochemicals have been listed in 

the Table 1. 

Dictamnine phytochemical is present 

in Dictamnus angustifolius (Wu et al., 

1999) vernacularly known as Burning 

bush, Gas plant or Fraxinella  
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Table 1: Showing top 10 phytochemicals found effective against Covid-19, ADME properties and their 

affinity with S-protein. 

Phytochemicals ADME Properties 

D
ru

g
 

L
ik

el
in

es
s 

A
ff

in
it

y
 

A
m

in
o
 

R
es

id
u

e 

Structure 

DICTAMNINE Properties Value

s 

Yes -20.4 THR 430  

PHE 515  

LEU 517  

HIS 519   

 

Molecular weight 

(<500 Da) 

199.2

1 

H-bond acceptor 

(<10) 

3 

H-bond Donor (5) 0 

LogP (<5) 2.38 

Molar 

Refractivity (40-

130) 

58.01 

Violations No 

DEOXYPODOPHYLLOTOXIN Molecular weight 

(<500 Da) 

398.4

1 

Yes -20.1 THR 430  

PHE 515  

LEU 517  

HIS 519   

 

 

H-bond acceptor 

(<10) 

7 

H-bond Donor (5) 0 

LogP (<5) 3.41 

Molar 

Refractivity (40-

130) 

102.6

8 

Violations No 

DEOXYARTEMISININ Molecular weight 

(<500 Da) 

266.3

3 

Yes -15.6 ASP 428   

ARG 355                   

 

H-bond acceptor 

(<10) 

4 

H-bond Donor (5) 0 

LogP (<5) 2.74 

Molar 

Refractivity (40-

130) 

69.29 

Violations No 

DAIDZEIN Molecular weight 

(<500 Da) 

254.2

4 

Yes -13.4 THR 430  

ASP 428  

 

H-bond acceptor 

(<10) 

4 

H-bond Donor (5) 2 

LogP (<5) 1.77 

Molar 

Refractivity (40-

130) 

71.97 

Violations No 

CINNAMALDEHYDE Molecular weight 

(<500 Da) 

132.1

6 

Yes -9.9 ASP 428  

SER 514  

 

H-bond acceptor 

(<10) 

1 

H-bond Donor (5) 0 

LogP (<5) 1.65 

Molar 

Refractivity (40-

130) 

41.54 

Violations No 

CITRAL Molecular weight 

(<500 Da) 

152.2

3 

Yes -9.9 SER 514  

ASP 428  

 

H-bond acceptor 

(<10) 

1 
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H-bond Donor (5) 0 

LogP (<5) 2.47 

Molar 

Refractivity (40-

130) 

49.44 

Violations No 

 

ALPHA-

APOPICROPODOPHYLLOTO

XIN 

 

Molecular weight 

(<500 Da) 

 

396.3

9 

 

Yes 

 

-8.6 

 

THR 430  

SER 514 

 

 

H-bond acceptor 

(<10) 

7 

H-bond Donor (5) 0 

LogP (<5) 3.32 

Molar 

Refractivity (40-

130) 

103.0

0 

Violations No 

CHELODONINE Molecular weight 

(<500 Da) 

353.3

7 

Yes -8.0 ARG 355  

THR 430  

SER 514   

HIS 519    

 

H-bond acceptor 

(<10) 

6 

H-bond Donor (5) 1 

LogP (<5) 3.21 

Molar 

Refractivity (40-

130) 

96.12 

Violations No 

SANGUINARINE Molecular weight 

(<500 Da) 

332.3

3 

Yes -8.0 ASN 343  

 

H-bond acceptor 

(<10) 

4 

H-bond Donor (5) 0 

LogP (<5) -0.04 

Molar 

Refractivity (40-

130) 

94.68 

Violations No 

STEMODIN Molecular weight 

(<500 Da) 

306.4

8 

Yes -7.7 ARG 355  

THR 430  

THR 430  

SER 514  

 

H-bond acceptor 

(<10) 

2 

H-bond Donor (5) 2 

LogP (<5) 3.2 

Molar 

Refractivity (40-

130) 

91.38 

Violations No 

It belongs to Rutaceae family, 

commonly found in temperate and open 

forest habitats of Southern Europe, North 

Africa, and mostly in Asia. More than a 

hundred chemicals have been extracted 

from this species like alkaloids, 

flavonoids, phenylpropane, limonoid 

triterpenoids, and coumarins.  

In Pakistan, it is found in Western 

Himalayas. Moreover, Dictamnine can be 

extracted from three species of genus 

Hortia (Rutaceae), namely H. brasiliana,  

 

 

H. longifolia, H. superba (Portela et al., 

2020).Dictamnine can cause cytotoxicity 

in women's cervix, colon, and oral 

carcinoma. Despite all these harmful side 

effects, it can combat bacteria and fungi 

like Saccharomyces cerevisiae, with a very 

low inhibitory concentration. Its 

interaction has been depicted in Figure 1. 
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i.  Deoxypodophyllotoxin 

The second highest (negative) energy 

was shown by Deoxypodophyllotoxin (-

20.1) at THR 430 (CO-OC, 3.1), PHE 515 

(CO-OH, 2.6), LEU 517 (CN-OC, 2.9), 

HIS 519 (CN-OC, 3.3) and HIS 519 (CN-

OC, 3.2) as shown in Table 1. 

Deoxypodophyllotoxin is alignin-type 

chemical with the potential to treat tumors 

and inflammation, Figure 2 (c). This 

phytochemical is highly bioactive as 

antiviral agent (Hu et al., 2016). It has 

been used for cancer treatments of human 

prostate gland (Hu et al., 2016), cervix 

(Yong et al., 2009) and breasts (Benzina et 

al., 2015). Deoxypodophyllotoxin is 

extracted from Anthriscus sylvestris 

(Apiaceae), Podophyllum hexandrum 

(Berberidaceae), Pulsatilla koreana 

(Ranunculaceae), Callitris intratropica 

Juniperus chinensis and J. procera 

 (a) (b) 

(c) (d) 

Figure 1: (a) Shows the cartoon view of interactions between Dictamnine and Covid S-protein, (b) 

Dictamnine showing the greatest interaction with S-protein residues: THR 430, PHE 515, LEU 517, HIS 

519 and HIS 519, (c) Showing the Dictamnine ligand which have maximum potential to bind with S-

protein, (d) Covid S-protein domain that is the active site for phytochemicals to bind with. 
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(Cupressaceae) (Muhammad et al,, 1995; 

Ali et al., 1998; Giri and Narasu, 2000; 

Kim et al., 2002). Among above 

mentioned Deoxypodophyllotoxin sources, 

P. hexandrum is native to Northern areas 

of Pakistan including Himalayan region 

and Gilgit Baltistan, South Asia, Eastern 

United States and Southeastern Canada.  

 (a)  (b)  

(c)  (d)  

Figure 2: (a) Cartoon view of Deoxypodophyllotoxin and S-protein of Covid-19, (b) Shows the sencond 

maximal interaction of Deoxypodophyllotoxin with THR 430, PHE 515, LEU 517, HIS 519 residues of S-

protein, (c) Separate view of Deoxypodophyllotoxin ligand, (d) The active site of Covid-19 S-protein 

domain that have affinity for different pytochemicals. 

In Pakistan it is hard to find it due to 

overexploitation for ethnomedicinal 

purposes. The whole plant is very 

poisonous except some ripened parts. It is 

also used as purgative and cytostatic. Due 

to its high toxicity, it has not yet been used 

clinically. Its interaction S-protein is being 

depicted in Figure 2 (a). 

 

ii. Deoxyartemisinin 
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Phytochemical Deoxyartemisinin 

showed binding energy -15.6 and 

interaction at ASP 428 (CO-OH, 2.1) and 

ARG 355 (CN-OC, 3.3) as shown in 

Figure 3 (a). It has been found effective to 

block the replication of the Covid-19 and 

its recent variants.  

It shows anti-malarial, anti-scabies, 

anti-Candida albicans infections, anti-

bacterial capabilities like E. coli, 

Salmonella, and other bacterial infections 

along with plasmodial parasites including 

Schistosomas (Cai et al., 2004; Mishina et 

al., 2007). Its interaction with S-protein 

has been depicted in Figure 3 (b).  

Deoxyartemisinin is extracted from 

Artemisia spp. especially A. annua 

belonging to Asteraceae family. It is also 

called Sweet wormwood, Sweet annie and 

Sweet sagewort. It is native to temperate 

Asia including Pakistan and China, but 

established itself in many countries like 

North America. In Pakistan, total 25 

species of genus Artemisia are extensively 

found (Ghafoor, 2002). In traditional 

remedies of many diseases these plants 

and their extracts are commonly used 

across the Pakistan. A. annua also has 

flavonoids which can block the replication 

of Covid-19. 

 (a) 

 

(b) 

 

(c) 

 

(d) 

 

Figure 3: (a) Deoxyartemisinin and S-protein (cartoon view) interactions at two binding sites namely: 

ASP 428 and ARG 355, (b) Deoxyartemisinin showing interaction with S-protein residues, (c) 3-D view of 

phytochemical Deoxyartemisinin ligand, (d) Covid-19 S-protein domain that provide active binding sites 

to the phytochemicals. 
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DISCUSSION 

Antiviral agents are used to reduce 

viral loads and stop the development of 

other respiratory infections. Plasma 

therapy, differential efficiency of vaccines  

and side-effect, and intensive mutation in 

the spike proteins of Covid-19 are 

emphasizing for the development of other 

chemo-active and inexpensive drugs 

(Basiri et al., 2021; Tenforde, 2021). 

Regenerative medicine are different cell-

tissue therapeutics (Basiri et al., 2021). 

The most effective drug can be made 

utilizing all the information regarding the 

biological and structural aspects. 

In this era of advancement in 

technology, screenings of drug-like small 

molecules has become very efficient by 

using various time efficient techniques and 

computer aided programs (Lim, et al. 

2012). Different types of parameters 

related to drug like molecules are 

optimized for successful drug discovery 

(Sliwoski, et al., 2014). In-silico drug 

designing and molecular docking involves 

determination of ligand-receptor 

interactions which depends on binding of 

bioactive lead compounds to desired 

receptor (Joseph et al, 2017). This 

approach for drug design has good clinical 

rates (Sehgal et al., 2018). For lead 

compound some explicit threshold energy 

to bind is must and conclusively shows 

drug characteristics. 

These lead bioactive compounds 

can easily be extracted from plants by 

using different techniques like High 

Performance Liquid Chromatography-

HPLC (Ingle et al., 2017). Isolated 

concentrated compounds have greater 

efficiency, lesser side effects and similar 

contrivances of mechanisms as synthetic 

drugs (Yadav and Agarwala, 2011). Most 

of the phytochemcials are toxic as 

Deoxyartemisinin (Sabir et al., 2010), the 

determination of proper dosage and 

administration is of utmost importance, All 

of our suggested phytochemicals can be 

used against Covid-19, after improving 

these compounds for ADME, enhancing 

their potency, bioavailability and reducing 

their toxicity (Ou-Yang, et al., 2012; Tung, 

2014). These tests with improvements can 

the lead drug into preclinical development. 

Phytochemicals are extracted from 

wild and cultivated plants that help against 

pathogenic microorganisms including 

viruses (Marjorie, 1996; Govindappa, et 

al., 2011). The evasion strategies used by 

the viruses are an important tool in giving 

insight for developing anti-viral drugs 

against them. Most of the phytochemicals 

have the ability to affect various steps of 

viral attack and replication so that their 

antiviral property is enhanced due to their 

specified mechanism.  

Phytochemical on binding with 

receptors induces some conformational 

changes in their structures. Further, blocks 

the progression of viral attack on the host 

cells. Molecular docking analysis involves 

the visualization of interaction between 

ligand (phytochemical) and receptor 

protein (Linota, et al., 2014).  It clearly 

shows these induced conformational 

changes on the binding of ligand and 

elucidates the drug action. (Russo et al., 

2020). The allosteric modulation by 

phytochemical ligands hinders the 

interaction of the S-protein and ligand is 

considered specifically in molecular 

studies.  

Several studies confirmed the 

application of useful phytochemicals as 

drugs for the treatment of potentially 

harmful ailments at no or minimum cost 

(Loew, et al, 1993; Dutta, et al, 2010; 

Leelananda and Lindert, 2016). Whereas, 

synthetic drugs require a large span of time 

to be made and are economically 

expensive (Mishra and Tiwari, 2011). 

More than 50 % of the world medicines 

are made from flora or their extracts 

(Ghani, 1998). Plants or their extracts are 

used for curing different conditions in 

human and animals. The important factor 

to utilize plants in sickness is high costs of 

allopathic medications and unapproachable 
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medical centers (Qureshi et al., 2006; 

Mahmood, et al., 2011; Mishra and Tiwari, 

2011). 

CONCLUSION 

From this study, it can be 

concluded that phytochemicals have great 

potential to inhibit S-protein to cure 

Covid-19 infection. In summation, present 

study aimed to screen or design a drug by 

using phytochemicals with no or less harm 

to block the association between S-protein 

of Covid-19 and ACE2 receptor of human 

cells. The selected residues for docking 

were PRO 330, CYS336, GLU340, 

ALA372, and CYS379. Some 

phytochemicals showed the lowest binding 

energy with the target protein. This 

binding energy shows suitable interactions 

of ligand to the target protein active site. 

These phytochemicals can block the viral 

binding site and reduce viral titers. 

Many phytochemicals like 

Dictamnine, Deoxypodophyllotoxin and 

Deoxyartemisinin showed the lowest 

binding energies and their efficacy was 

confirmed by molecular docking as well. 

The source plants of these phytochemicals 

are Dictamnus albus Anthriscus sylvestris 

or Podophyllum spp.and Artemisia annua, 

respectively. They have anti-Covid-19 and 

anti-inflammatory agents. These 

phytochemicals are under trial and might 

be used in future to prevent and cure 

Covid-19. Although, these studies have 

revealed promising results but there is a lot 

to be done in this regard to check the 

effectiveness of phytochemicals in 

combating viral infections, their success in 

clinical trials, and the cost-effectiveness. 

To that end, future works must focus for 

collecting, purifying and characterizing 

these suggested chemicals.  
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